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Installation

This document provides instructions for the initial installation of the ICS-2000 Ion 
Chromatography System. 

NOTE The order of the steps is important. It is especially
important to install Chromeleon® before connecting the
USB cable and turning on the ICS-2000 power.

1 Facility Requirements

• Make sure the ICS-2000 installation site meets the following environmental 
specifications:

Operating Temperature: 4 to 40 °C (40 to 104 °F)

Humidity: 5% to 95% relative humidity, noncondensing

• Provide a sturdy workbench for the ICS-2000 of a height that ensures 
convenient access to the interior of the ICS-2000.

• Allow at least 15 cm (6 in) behind the ICS-2000 for power connections and 
ventilation. For optimal performance, install the ICS-2000 in a draft-free 
location, out of the path of air conditioning and heating vents.

• (Optional) Provide a clean gas source regulated to between 0.55 and 
0.83 MPa (80 and 120 psi) for pressurization of the eluent reservoir.

• Use ASTM filtered, Type I (18-megohm) deionized water when preparing 
eluent and regenerant.
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2 Unpacking the ICS-2000 System

1. After removing the ICS-2000 from the shipping box and removing the top 
layer of foam, remove the next layer of foam (see Figure 1).

Figure 1. Unpacking the ICS-2000

2. Set the eluent bottle on top of the 
ICS-2000 (see Figure 2).

3. TURN OVER THE EGC 
HOLDER, and set it on top of the 
ICS-2000.

Figure 2. ICS-2000 After Installing
Eluent Bottle and EGC Holders

Eluent 
Bottle

EGC Holder
(upside down)

EGC Holder
(right-side up)
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4. Remove the next layer of foam and remove the Ship Kit box (see Figure 3).

Figure 3. ICS-2000 with Ship Kit

5. The bottom foam layer has two cutouts on either side of the ICS-2000 
module; use these as handholds when lifting the module (see Figure 3). 

6. Lift the ICS-2000 out of the bottom layer of foam and set it on a workbench. 
Inspect the ICS-2000 for any shipping damage.

Two or more persons should lift the ICS-2000, which weighs 30 kg
(66 lb). Lift the ICS-2000 only from each side of the cabinet bottom.
Lifting from the front door will damage the door hinges.

Au moins deux personnes peuvent soulever le ICS-2000:  il pèse 30 kg
(66  lb). Ne soulevez le ICS-2000 que par chaque côté du fond de
l'armoire. Son soulèvement par la porte du panneau avant
endommagera les charnières de la porte.

Der ICS-2000 wiegt über 20 kg. Daher sollte das Gerät nur von zwei
oder mehr Personen angehoben werden. Greifen Sie dazu an beiden
Seiten unter das Gerät. Heben Sie den Autosampler nicht an der
Vordertür an, da dadurch die Türangeln beschädigt werden könnten.

Ship
Kit 

Cutouts 
for lifting
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2.1 Unpacking the Computer (North America only)

NOTE These instructions assume that Chromeleon
software was installed on the computer before
shipping. 

1. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

2. Remove the monitor from its box and place it on the workbench.

3. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

4. Go on to Section 4, “Installing the Chromeleon Software License.”

2.2 Unpacking the Computer (outside North America)

1. Refer to Installing the Chromeleon IC System (Document No. 
031883) to verify that the computer being used meets Chromeleon 
specifications. The manual is on the Dionex Reference Library CD-
ROM (P/N 053891).

2. Remove the central processing unit (CPU), keyboard, mouse, and all 
documentation from the computer box and place these items on a 
workbench.

3. Remove the monitor from its box and place it on the workbench.

4. Follow the instructions in the computer installation guide to hook up 
the monitor, mouse, keyboard, and CPU.

5. If Chromeleon is not installed on the computer, go on to Section 3, 
“Installing Chromeleon.”

6. If Chromeleon is already installed on the computer, go on to 
Section 4, “Installing the Chromeleon Software License.”
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3 Installing Chromeleon

NOTES
• Windows® 2000 or Windows XP is required for controlling the ICS-2000 

with Chromeleon. Chromeleon version 6.5 SP2 or later is required.

• To install Chromeleon, you must log onto Windows 2000 or XP with 
administrator privileges. Administrator privileges are not required to 
run Chromeleon.

• For additional details about installing Chromeleon, refer to Installing the 
Chromeleon Chromatography Management System with a Dionex Ion 
Chromatograph (IC) (Document No. 031883)

1. Turn on the computer power.

2. Follow the Windows setup steps as they appear on the screen.

3. Verify that the monitor display is set to a minimum of 1024 x 768 with 16 bit 
color.

4. Insert the Chromeleon CD-ROM into the CD-ROM drive.

5. The Chromeleon Setup menu appears.

6. If the Setup menu does not appear automatically, go to the Autorun folder on 
the Chromeleon CD-ROM and double-click autorun.exe.

7. Select Launch Chromeleon Setup.

8. Setup now guides you through the installation procedure; follow the on-
screen instructions as they appear. 

9. When prompted, select whether to add the Chromeleon Server Monitor to the 
Startup group. If you select yes, the Server Monitor starts automatically when 
the computer is started, and the program icon appears in the taskbar.

10. After installing the software, restart the computer.

11. Go on to Section 4, “Installing the Chromeleon Software License.” 
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4 Installing the Chromeleon Software License

For the Chromeleon computer to control the ICS-2000, a valid software license 
must be installed. To install the license, you first install a dongle on the computer 
and then enter a license “Key Code” in Chromeleon. (A dongle is an adapter that 
is connected to the parallel PC interface or USB port. The dongle stores the serial 
number of a Chromeleon computer.)

NOTE If the software license is managed with a License
Server, a dongle is not required. 

1. Plug the dongle into the appropriate port on the computer (either the parallel 
or USB port, depending on the type of dongle). Tighten the connector screws 
on a parallel port dongle.

2. Microsoft Windows will automatically detect the USB dongle and launch the 
Found New Hardware Wizard. Complete the wizard by selecting the 
following options: 

• If asked whether Windows can connect to Windows Update to search for 
software, select No, not this time.

IMPORTANT
Installing DX-LAN Devices
If you will also be installing a module that requires a DX-LAN interface 
connection, verify that the following steps are completed before continuing:

1. If it is not already installed, install the DX-LAN card in the module. Refer 
to the operator’s manual for the module for installation instructions.

2. Install the DX-LAN card in the computer.

3. Connect the module to the DX-LAN.

4. Install the DX-LAN card driver.

Instructions for Steps 2 through 4 are in Installing the Chromeleon 
Chromatography Management System with a Dionex Ion Chromatograph (IC) 
(Document No. 031883).
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• Select the Install the software automatically (Recommended) option (see 
Figure 4) (it is not necessary to insert a hardware installation CD or floppy 
disk).

Figure 4. Windows Found New Hardware Wizard

3. If it is not already running, start the Chromeleon Server Monitor by double-
clicking the Server Monitor icon on the Windows taskbar.

If the Server Monitor icon is not on the taskbar, click Start on the taskbar and 
select All Programs > Chromeleon > Server Monitor. 
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4. If the server is not already running, start it by clicking Start (see Figure 5).

5. Check the server status:

• If “Chromeleon Server is running idle” is displayed, the license Key Code 
was entered before shipping the computer, and you can omit the 
remaining steps in this section. Click Close and go on to Section 5.

• If “Chromeleon Server is running idle (Evaluation Mode)” is displayed 
(see Figure 6), the license Key Code has not yet been entered. If this is the 
case, go on to Step 6.

6. Open Chromeleon (select Start>Programs (or All 
Programs)>Chromeleon>Chromeleon).

Figure 5. Server Not Running

Figure 6. Server Evaluation Mode
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7. Select File>Preferences to open the Preferences dialog box (see Figure 7). 
Select the License tab and click Dongle. Enter the Key Code exactly as it 
appears on the Chromeleon Software License key code sheet. Click OK.

8. Check the Server Monitor status. It should now display “Chromeleon Server 
is running idle.” (see Figure 8).

9. Click Close to close the Server Monitor window.

10. Go on to Section 5.

Figure 7. Preferences: License Page

Figure 8. Server Running
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5 Connecting the ICS-2000 to the Chromeleon PC

The ICS-2000 rear panel provides a USB receptacle for connecting the ICS-2000 
to a USB port on the Chromeleon PC. The rear panel also provides two USB ports 
for connecting other Dionex USB-compliant modules to the system.

5.1 Connecting the ICS-2000 to the PC

1. Locate the USB cable (P/N 960779) in the ICS-2000 Ship Kit 
(P/N 064375).

2. Plug the cable’s “A” connector into a USB port on the Chromeleon 
PC and plug the cable’s “B” connector into the USB receptacle 
(labeled FROM PC) on the ICS-2000 rear panel (see Figure 9).

Do not turn on the power to the ICS-2000 or other USB module(s) until
after you connect the USB cable.

Before connecting the USB cable, verify that Chromeleon is installed.
If not, Windows will be unable to identify the new USB device when
the power is turned on. See Section 3 to install Chromeleon. 

Figure 9. Example Connections: One ICS-2000 Connected to the Computer

ICS-2000

USB Cable A

B

Plug the “B”
into the FROM PC 

receptacle on the ICS-2000.

USB cable’s 
connector 

Plug the “A”
into USB 

port on the Chromeleon PC.

USB cable’s 
connector the 

Chromeleon PC

FROM PC USB receptacle 
on the ICS-2000 rear panel
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5.2 Connecting Additional USB Devices

The ICS-2000 provides two USB ports for connecting additional Dionex 
USB-compliant modules to the system.

To connect an additional USB module, plug the “A” connector on a USB 
cable into an “A” port (labeled TO MODULE) on the ICS-2000 rear panel 
and plug the cable’s “B” connector into the USB receptacle on the USB 
module (see Figure 10).

NOTE If the number of USB devices in the system exceeds the
number of available USB ports, connect the devices to
the system with a USB-compliant, full-speed external
hub. One or more hubs is also required if the ICS-2000
or other USB device is more than 5 meters (16 ft) from
the PC. Refer to the manual provided by the hub vendor
for complete installation instructions. 

Figure 10. Example Connections: Two Dionex USB Modules 
Connected to the ICS-2000

The USB standard limits the USB cable length to 5 meters (16 ft). Each
USB device can be separated from the PC by no more than five hubs.
Thus, each USB device can be located no more than 30 meters
(32 yds) from the PC.
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6 Connecting the Power Cord

Connect the power cord (IEC 320 C13) (ordered separately) from the main power 
receptacle on the rear panel to a grounded power source. The ICS-2000 power 
supply is auto-sensing, so no adjustment is required to select the line voltage.

Go on to Section 7.

SHOCK HAZARD—To avoid electrical shock, use a grounded
receptacle. Do not operate the ICS-2000 or connect it to AC power
mains without an earthed ground connection.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the ICS-2000 and is easily
accessible. 

Operation at AC input levels outside of the specified operating voltage
range may damage the ICS-2000.

DANGER D'ÉLECTROCUTION—Pour éviter toute électrocution, il faut
utiliser une prise de courant avec prise de terre. Ne l'utilisez pas et ne
le branchez pas au secteur C.A. sans utiliser de branchement mis à la
terre.

Le cordon d'alimentation principal est utilisé comme dispositif
principal de débranchement. Veillez à ce que la prise de base soit
située/installée près du module et facilement accessible.

STROMSCHLAGGEFAHR—Zur Vermeidung von elektrischen
Schlägen ist eine geerdete Steckdose zu verwenden. Das Gerät darf
nicht ohne Erdung betrieben bzw. an Wechselstrom angeschlossen
werden.
Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.
Stellen Sie sicher, daß sich die Steckdose nahe am Gerät befindet und
leicht zugänglich ist.
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7 Turning On the ICS-2000 Power

1. If it is not already on, turn 
on the computer power and 
log onto Windows 2000 or 
Windows XP as an 
administrator.

2. If the Chromeleon Server is 
not running (the icon on the 
taskbar is crossed out in red 

), start the Server by 
right-clicking the icon and 
selecting Start Server. 
When the server starts, the 

icon changes to gray . 

3. Press the power switch on 
the ICS-2000 rear panel (see 
Figure 11) to turn on the 
power. 

Figure 11. ICS-2000 Rear Panel

4. Windows automatically detects the new USB device. A message flashes on 
the screen to inform you that new hardware was found. 

Before turning on the ICS-2000 power, verify that Chromeleon
software is installed. See Section 3 for installation instructions. If
Chromeleon is not installed first, Windows will be unable to identify
the new USB device.

Power
Switch
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5. The Found New Hardware Wizard appears. This wizard installs the ICS-2000 
device into the Windows Device Manager. Complete the wizard by selecting 
the following options:

• If asked whether Windows can connect to Windows Update to search for 
software, select No, not this time.

• Select the Install the software automatically (Recommended) option 
(see Figure 12). 

• After you click Next, Windows installs the software.

• When the wizard finishes installing the software, click Finish.

6. Go on to Section 8.

Figure 12. Windows Found New Hardware Wizard
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8 Setting Up Chromeleon

NOTE This section provides brief instructions for setting up
Chromeleon. For details about any of these steps, refer
to the Chromeleon user’s guide or online Help.

8.1 Assigning the ICS-2000 to a Timebase

After the ICS-2000 power is turned on and the Windows Found New 
Hardware Wizard is finished, the Chromeleon USB Auto Configuration 
Wizard automatically appears. The wizard presents two options (see 
Figure 13):

Figure 13. Chromeleon USB Auto 
Configuration Wizard: Page 1
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To create a new timebase:

1. Select the Create a new timebase option and click OK.

Page 2 of the wizard appears (see Figure 14).

Figure 14. Chromeleon USB Auto Configuration Wizard: Page 2

2. Review the names displayed in the Unassigned USB Devices 
Detected window. If the list includes the name of a device that you do 
not want to configure now, clear the check mark before the device 
name.

If you are installing more than one ICS-2000, you can verify the serial 
numbers for each by checking the label on the component panel. The 
serial number is also shown on the INFORMATION touch screen page. 
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3. In the Mode window, select a pre-defined configuration template for 
the new timebase. Typically for the ICS-2000, one configuration is 
available: Single (1 timebase with single system but no sharing 
device). The Description box lists the devices included in the mode. 
Devices in brackets are optional.

4. Select the Launch Server Configuration upon closing this wizard 
check box.

The check box is disabled if the Server Configuration program is 
already running.

5. Click Accept to create a new timebase. 

The Server Configuration automatically starts running when you 
close the wizard. If the Server Configuration was already running, it 
is updated with the new configuration information.

To add an unassigned USB device to an existing timebase: 

1. In the Chromeleon USB Auto Configuration Wizard, select the Add 
device to an existing timebase option and click OK.

This launches the Server Configuration program. 

2. Select an existing timebase to which the ICS-2000 can be assigned.

3. When you finish making changes here, click OK to close the dialog 
box.

The Server Configuration program window appears.
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To verify the configuration:

1. In the Server Configuration program, click the + icon next to the 
server name to expand the folder. The timebase you created is 
displayed (see Figure 15).

Figure 15. Server Configuration with ICS-2000 Timebase

2. To verify that the ICS-2000 is correctly connected to the timebase, 
double-click its name under the timebase. Click Yes if the following 
message appears: “Communication to the device will be stopped…Do 
you want to continue?”
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3. The ICS-2000 System dialog box opens (see Figure 16). The General 
page shows the Device Name (Pump_ECD), the Mode (Live), and 
the Module Serial No. 

4. Close the dialog box and then save the configuration (select 
File>Save Installation).

5. If you are going to add one or more DX-LAN devices to the timebase, 
go on to Section 8.2. Otherwise, exit the Server Configuration 
program and then go on to Section 9.

Figure 16. ICS-2000 System Properties
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8.2 Assigning DX-LAN Devices to the Timebase (Optional)

Follow the instructions in this section if you are adding one or more 
devices to the timebase that are connected to the PC through a DX-LAN 
interface (not through USB connections).

1. Follow the instructions in Installing the Chromeleon 
Chromatography Management System with a Dionex Ion 
Chromatography (IC) (Document No. 031883) to add the DX-LAN 
card to the server configuration as a sharable device.

2. Select the timebase that was created for the ICS-2000 (see Figure 17); 

then, click the Add device icon  on the toolbar (or select 
Edit>Add Device).

Figure 17. Example: ICS-2000 Timebase

The Add device to timebase dialog box appears.
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3. Under Manufacturers, select Dionex: IC Modules and then select 
the device from the Devices list. 

4. Click OK. A configuration properties dialog box for the device 
appears. Figure 19 shows an example of the properties for an AS50 
Autosampler.

Figure 19. AS50 Configuration Properties

Figure 18. Add Device to Timebase Dialog Box
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5. On the General tab page, clear the Demo Mode check box if it is 
currently selected, and then select the DX-LAN Device ID number. 
Note: Devices display their DX-LAN ID numbers when their power 
is turned on.

6. Click OK to close the dialog box. 

7. Save the configuration (select File>Save Installation). 

8. Exit the Server Configuration program.

9. Go on to Section 9.
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9 Installing and Plumbing the Columns and Suppressor

NOTE This section provides brief installation and plumbing
instructions for the columns and suppressor. Before
beginning the installation, refer to the column and
suppressor manuals for detailed start-up and
installation instructions. The manuals are provided on
the Dionex Reference Library CD-ROM (P/N 053891).

Before beginning:

• Remove the guard column, separator column, and suppressor from their 
boxes. 

• Remove the fitting plugs from the ends of each column and from all ports on 
the suppressor. 

• Discard any tubing temporarily connecting the suppressor ports.

9.1 Setting Up the Column Heater 

1. Cut off the two 
shipping ties from 
the column heater 
and remove them 
(see Figure 20).

2. Loosen the two 
thumbscrews on 
the heater cover 
(they remain 
attached to the 
cover).

3. Pull the heater 
cover straight out 
to remove it.

Figure 20. ICS-2000 Column Heater Setup

Thumbscrew (2)

Shipping Tie (2)
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4. Unscrew the six 
thumbscrews on the 
top metal plate (see 
Figure 21) and 
remove the plate.

5. Go on to 
Section 9.2.

Figure 21. ICS-2000 Column Heater Cover Removed

9.2 Installing the Columns

1. Remove the coupler connecting GUARD IN and GUARD OUT.

2. Connect GUARD IN to the guard column inlet. Check the arrow on the 
column label; it should point down (flow away from the injection 
valve).

3. Connect GUARD OUT to the guard column outlet.

4. Push the guard column onto the back column clip.

5. Remove the coupler connecting COL IN and COL OUT. 

6. Connect COL IN to the separator column inlet. Connect COL OUT to 
the separator column outlet. Check the arrow on the column label. It 
should point up (flow toward the cell).

7. Push the separator column onto the front column clips.

8. Replace the top metal plate on the column heater.

Thumbscrew (6) 
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9.3 Installing the Suppressor

1. Locate the suppressor 
mounting tabs on the 
component panel (see 
Figure 22). Reach into 
the opening between the 
tabs and pull the yellow 
connector and attached 
cable slightly out of the 
opening.

2. Connect this cable to the 
cable from the 
suppressor (align the 
pins on the two 
connectors and push 
them together).

Figure 22. 
Suppressor Mounting Tabs 

and Guidelines

3. Orient the suppressor with the REGEN OUT fitting on top and the 
cable to the right. 

4. Feed the cable into the opening in the component panel.

5. Align the top of the suppressor with the guideline printed on the 
component panel (see Figure 22) and align the slots on the rear of the 
suppressor with the tabs on the panel.
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Suppressor 
Mounting Tabs
Suppressor 
Cable Connector
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SRS
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6. Press the suppressor onto the tabs 
and then slide it down to lock it in 
place. Pull slightly on the center of 
the suppressor to verify that it is 
securely fastened. Figure 23 shows 
an SRS suppressor installed on the 
component panel.

7. Remove the coupler connecting 
ELUENT IN and ELUENT OUT and 
connect these lines to the 
corresponding ports on the 
suppressor.

Figure 23. Suppressor Installed 
(SRS Shown)

8. Remove the fitting plug from REGEN IN and connect it to the REGEN 
IN port on the suppressor. Do not connect the REGEN OUT port until 
after completing the eluent generator setup (Section 14).

9. Replace the cover on the column heater, making sure the GUARD IN 
line is aligned with the slot on the side of the heater cover. 

10. Go on to Section 10.
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10 Connecting the Waste Lines

The ICS-2000 has the following waste lines:

• PUMP WASTE carries prime waste from the pump. 

• TO WASTE OUT carries sample overflow from the injection valve. 

• WASTE, GAS SEPARATOR carries system waste from the suppressor.

1. Untape the coiled waste lines from the rear panel. Place the ends of the PUMP 
WASTE and TO WASTE OUT lines into a waste container. 

2. Direct the WASTE, GAS SEPARATOR line from the top of the ICS-2000 to the 
rear panel. Snap the line onto one of the tubing clips on the rear panel. 
Connect the line to the gas separator waste tube (see Section 10.1).

NOTE To prevent waste from siphoning back into the system,
check the lines periodically to be sure they are not bent,
pinched, or elevated at any point.

10.1 Installing the Gas Separator Waste Tube

1. Locate the gas 
separator waste tube 
assembly in the ICS-
2000 Ship Kit 
(P/N 064375).

2. Connect the WASTE, 
GAS SEPARATOR 
line from the 
suppressor to one of 
the 3-mm (1/8-in) ID 
white Teflon lines on 
the gas separator 
waste tube assembly 
(see Figure 24).

Figure 24. Gas Separator Waste Tube Installation

3. Place the gas separator waste tube assembly into the waste container. 
Make sure the tubing junction (where the white Teflon tubing meets 
the black polyethylene tubing) is above the top of the container and 

Gas Separator
Waste Tube
Assembly

Waste

Waste, Gas
Separator Line

(from the suppressor)

This line is 
provided for a 
second system
if needed.

Open to 
the air
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that the gas separator waste tube and the waste container are open to 
the atmosphere.

4. Go on to Section 11.

DO NOT CAP THE WASTE CONTAINER: The ICS-2000, Atlas
Electrolytic Suppressor, and Self-Regenerating Suppressor (SRS) use
an electrolytic process that results in the production of small amounts
of oxygen or hydrogen gas. To ensure that the gas is not trapped in a
closed container and allowed to concentrate, install a 1.3-cm (0.52-in)
ID black gas separator waste tube (P/N 045460) in an uncapped waste
container. Connect the Waste, Gas Separator line to the waste tube
(see Figure 24).

NE FERMEZ PAS LE CONTENEUR DE GAZ RÉSIDUEL: Le ICS-2000, le
Atlas Electrolytic Suppressor, et le Self-Regenerating Suppressor
(SRS) travaillent avec un proces d´électrolyse, qui produit des petites
quantités de gaz d´oxygène ou d´hydrogène. Afin de garantir que le
gaz ne soit pas enfermé dans un conteneur fermé et puisse s´y
concentrer, connectez un tube noir à gaz résiduel (diamètre intérieur =
1,3 cm; n° de commande 045460) à un conteneur ouvert (non fermé).
Connectez le conteneur résiduel au tube résiduel/gaz séparateur
(désigné: « Waste, Gas Separator»). 

VERSCHLIESSEN SIE DEN ABFALLBEHÄLTER NICHT: Der ICS-2000,
Atlas Electrolytic Suppressor und Self-Regenerating Suppressor
(SRS) verwenden einen Elektrolyseprozess, wodurch kleine Mengen
an Sauerstoff und Wasserstoff entstehen. Führen Sie einen
schwarzen Gasabscheiderschlauch (ID = 1,3 cm; Bestell-Nr. 045460) in
einen offenen (unverschlossenen) Abfallbehälter, damit sich das Gas
nicht in einem geschlossenen Behälter sammelt und aufkonzentriert.
Verbinden Sie die mit Waste, Gas Separator bezeichnete Leitung mit
dem Abfallschlauch.
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11 Setting Up the Eluent Reservoir

1. Rinse the eluent reservoir.

2. Fill the reservoir with ASTM filtered, Type I (18-megohm) deionized water.

3. Place the reservoir on top of the ICS-2000.

4. Install the cap and handtighten.

NOTE The ICS-2000 does not require pressurized reservoirs.
However, if eluent is manually degassed or is sensitive to
contamination, Dionex recommends pressurizing the
reservoir with helium or nitrogen. See Section 21 for
instructions.

5. Go on to Section 12.
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12 Setting the Eluent Level

After filling the reservoir, open the touch screen HOME page and enter the volume 
of liquid in the reservoir in the Eluent Level field (see Figure 25), or enter the 
volume in the Eluent Bottle field on the Chromeleon Control panel (see 
Figure 26). The ICS-2000 determines the eluent usage, by monitoring the flow 
rate and the length of time the pump is on, and updates the field as the eluent is 
used up. A warning is displayed if the level falls below 200 mL. The warning is 
repeated at 100 mL and at 0 mL. 

Go on to Section 13.

In order for the eluent level displayed on the screen to be accurate,
the level must be entered by the user when the reservoir is filled. The
ICS-2000 does not automatically detect when the reservoir is filled,
nor when it is empty.

Figure 25. Home Page: Setting the Eluent Level

Figure 26. Chromeleon Control Panel: Setting the Eluent Level

Enter the volume of
liquid in the reservoir

Note: The Eluent Level 
field is updated as the 
liquid is used up.

Enter the volume of
liquid in the reservoir

Note: The Eluent Bottle 
field and slider gauge 
are updated as the 
liquid is used up.
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13 Priming the Pump

1. Verify that the eluent reservoir is filled, the reservoir cap is installed and 
handtightened, and the liquid line from the ICS-2000 to the reservoir cap is 
connected (see Section 11).

2. Verify that the waste lines are directed to a waste container.

3. The priming procedure consists of two parts:

• Priming the eluent lines with a syringe (see Section 13.1). Perform this 
procedure at initial installation, after changing eluents, or when eluent 
lines are empty.

• Priming the pump heads with the Prime button (see Section 13.2). 
Perform this procedure after the eluent lines are primed.
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13.1 Priming the Eluent Lines with a Syringe 

NOTE Prime the eluent lines after initial installation, after
changing eluents, or when eluent lines are empty.

1. Verify that the pump is turned off.

2. Connect a 10 mL syringe (P/N 054578) to the port in the priming 
valve on the primary pump head (see Figure 27). 

3. Open the priming valve by turning it one-quarter to one-half turn 
counterclockwise.

4. On the ICS-2000 touch screen, touch the page name (for 

example, ) in the bottom right corner to open a menu 
of pages.

Figure 27. Priming the Eluent Lines

10 mL Syringe
(P/N 054578)

Priming Valve 
(open)

Port

Waste Valve
(close)

Primary
Pump Head

Secondary
Pump Head
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5. Touch PUMP to open the touch screen PUMP page (see Figure 28). 
Under Eluent Valve, touch the Open button.

6. Draw the syringe back to begin pulling eluent through the flow path. 
It may take several syringe draws to remove all air or previous eluent 
from the tubing. Draw out a minimum of 20 mL of eluent to ensure 
that the vacuum degas assembly is primed.

7. After priming the lines thoroughly, close the priming valve. Do not 
overtighten the priming valve. 

8. Touch Eluent Valve Closed on the touch screen PUMP page.

Figure 28. Pump Page: Eluent Valve Open
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13.2 Priming the Pump Heads with the Prime Button

NOTE Perform this procedure after priming the eluent
lines (see Section 13.1).

1. Check that the priming valve on the primary pump head is closed (see 
Figure 29).

2. Open the waste valve on the secondary pump head by turning the 
knob one-quarter to one-half turn counterclockwise (see Figure 29). 
Opening the valve directs the eluent flow path to waste and eliminates 
backpressure.

3. Touch Prime on the ICS-2000 touch screen HOME page. Confirm that 
the waste valve is open by pressing OK when the reminder message 
appears. The pump will begin pumping at approximately 3 mL/min.

4. Continue priming the ICS-2000 until no air bubbles are exiting the 
pump waste line.

5. Press Pump Off.
6. Close the waste valve. Do not overtighten. The pump is now ready 

for operation.
7. Go on to Section 14.

NOTE If the two standard priming procedures described
above are unsuccessful, prime the pump with
isopropyl alcohol. See “Chapter 5,

Figure 29. Priming the Pump

Priming Valve

Waste Valve

Primary
Pump Head

Secondary
Pump Head

(open)

(close)
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Troubleshooting,” in the ICS-2000 operator’s
manual for instructions.

14 Setting Up the Eluent Generator

Before Beginning
Remove the EluGen cartridge (EGC) and the other items to be installed from their 
shipping containers. Depending on the type of eluent to be generated, the other 
items may include a Continuously Regenerated Trap Column (CR-TC), an EPM 
Electrolytic pH Modifier, and/or an EGC CO3 Mixer. 

NOTE The EGC degas assembly is installed inside the EGC
holder at the factory.

Refer to the EluGen cartridge, CR-TC, and EPM manuals for the optimal 
operating conditions for your application. The manuals are provided on the 
Dionex Reference Library CD-ROM (P/N 053891).

The EluGen cartridge contains one of the following: a corrosive base
(KOH, LiOH, or NaOH), a corrosive acid (MSA), or a concentrated
K2CO3 solution. Wear protective eyewear and gloves when handling
the cartridge.
La cartouche d'EluGen contient un de ce qui suit: une base corrosive
(KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une solution
concentrée de K2CO3. Porter des lunettes et des gants protectives en
manipulant la cartouche.
Die EluGen-Kassette enthält eine korrodierende Base (KOH, LiOH
oder NaOH), eine korrodierende Säure (MSA) oder eine konzentrierte
K2CO3-Lösung. Tragen Sie daher beim Umgang mit Kassette eine
Schutzbrille und Handschuhe.
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14.1 Eluent Generator Setup for KOH, LiOH, MSA, and NaOH 
Eluents

Follow the instructions in this section if you are installing a KOH, LiOH, 
MSA, or NaOH EluGen cartridge and a CR-TC.

• If you are installing a K2CO3 cartridge, an EPM, and an EGC CO3 
Mixer (for generating carbonate/bicarbonate eluent), go to 
Section 14.2.

• If you are installing a K2CO3 cartridge and an EGC CO3 Mixer (for 
generating carbonate eluent), go to Section 14.3.

Overview

The eluent generator setup procedure for KOH, LiOH, MSA, or NaOH 
eluents consists of the following main steps:

• Installing the CR-TC.

• Installing the EluGen cartridge.

• Connecting the EluGen cartridge vent line.

• Recording the EluGen cartridge serial number in Chromeleon.

• Conditioning the EluGen cartridge.

• Hydrating the CR-TC.

• Completing the eluent generator setup.
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Items Required to Complete the Setup Procedure

In addition to the EluGen cartridge and the CR-TC, you will need the 
following items to complete the eluent generator setup.

Item P/N Use To

Yellow 0.5 mL/min, 7 MPa 
(1000 psi) backpressure coil 
(supplied in the ICS-2000 
Ship Kit (P/N 064375))

053765 Provide backpressure during 
setup procedures.

EluGen Cartridge Vent Line 
Tubing Kit 
(supplied with the cartridge)

063092 Vent the cartridge during 
operation.

10-32 to 1/4-28 coupler 
(supplied in the ICS-2000 
Ship Kit)

042806 Temporary connection during 
setup procedures.

Temporary waste container 
(beaker, bottle, etc.) 
(not supplied)

n/a Collect waste during setup 
procedures.

10-32 fittings
10-32 ferrules

043275
043276

Complete the connections

1/8-in fittings
1/8-in ferrules

052267
048949

Complete the connections
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Figure 30 illustrates the ICS-2000 after the EluGen cartridge is installed.

Figure 30. ICS-2000 with an EluGen Cartridge Installed (Top View)

IN EGC OUT

EluGen
Cartridge

(EGC)

EGC Holder

EGC and
CR-TC Cable
Connections
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Figure 31 illustrates the liquid flow path through the eluent generator 
components after all setup steps are complete and the eluent generator is 
ready for operation.

Figure 31. Eluent Generator Flow Schematic with CR-TC: 
Use for Generating KOH, LiOH, MSA, or NaOH Eluent 
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Installing the CR-TC

1. Tilt the cartridge 
holder to view the 
bottom of the holder 
and brace the holder 
against the back corner 
of the ICS-2000 (see 
Figure 32).

Figure 32. Cartridge Holder (tilted to view the bottom)

2. Before installing the 
CR-TC, note the metal 
ball stud inside the 
bottom of the cartridge 
holder (see Figure 32) 
and the bracket on the 
CR-TC mounting 
plate (see Figure 33). 
These are used to 
mount the CR-TC 
inside the holder after 
it is plumbed. 

Figure 33. CR-TC

3. Remove the plugs from the four ports, labeled “P” in Figure 33. Do 
not remove the two electrical connections, labeled “E” in the 
figure.

Metal ball stud 
for mounting 
the CR-TC

 Bracket for mounting the

P=Port (4)
(Remove plugs)

E= Electrical connection (2)
(Do not remove) 

P
P

P
P

E

E

CR-TC on the holder 
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4. With the CR-TC oriented as shown in Figure 34, connect each line to 
the corresponding port on the CR-TC.

NOTE To help retain the fittings and ferrules on the lines,
remove the coupler from each line just before
connecting the line to a port. 

 

Figure 34. Plumbed CR-TC

5. Check that none of the lines are caught under the CR-TC and then 
push the CR-TC onto the metal stud inside the EGC holder (see 
Figure 35). Push down until the CR-TC snaps into place. 

Figure 35. CR-TC Installed in Holder

Regen Out

Regen In

Eluent 
Eluent In Out 
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6. Feed the CR-TC cable through the slot on the side of the EGC holder 
(see Figure 36).

7. Turn the EGC holder right-side up and set it back into position.

Installing the EluGen Cartridge

1. Orient the EluGen 
cartridge with the fittings 
facing up and remove the 
plugs from the EluGen 
cartridge INLET and 
OUTLET ports (see 
Figure 37).

Figure 37. EluGen Cartridge Inlet and Outlet Ports

Figure 36. Installing the CR-TC 

CR-TC 
Cable

OUTLET

INLET
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2. Set the EluGen cartridge in the service area on top of the ICS-2000 
and orient it with the cable toward the EGC holder (see Figure 38).

3. Pull the coiled black EGC IN and EGC OUT lines out slightly from the 
cartridge holder. 

4. Disconnect the EGC 
IN line from the 
union that connects 
it to the EGC OUT 
line.

5. Connect EGC IN to 
the EGC INLET port 
(see Figure 39).

Figure 39. EGC Inlet Port Connections

Figure 38. EluGen Cartridge in Service Area

EGC Cable

EGC IN
INLET
Port
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6. Locate the yellow 
0.5 mL/min, 7 MPa 
(1000 psi) 
backpressure coil 
(P/N 053765) in the 
ICS-2000 Ship Kit 
(P/N 064375). 

7. Connect one end of 
this coil to the EGC 
OUTLET port (see 
Figure 40). Leave 
the other end of the 
coil unconnected. 

Figure 40. 
EG

C Outlet Connection for 
Conditioning the EGC

NOTE The backpressure coil connection is temporary; it is
required only during the EluGen cartridge
conditioning procedure described in “Conditioning
the EluGen Cartridge” on page 2-49.

8. Turn the EluGen cartridge over (with the fittings facing down). Shake 
the EluGen cartridge vigorously, and tap it with the palm of your 
hand 10 to 15 times. Check that all bubbles trapped in the eluent 
generation chamber are dislodged. 

The EluGen cartridge contains one of the following: a corrosive base
(KOH, LiOH, or NaOH), a corrosive acid (MSA), or a concentrated
K2CO3 solution. Wear protective eyewear and gloves when handling
the cartridge.
La cartouche d'EluGen contient un de ce qui suit: une base corrosive
(KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une solution
concentrée de K2CO3. Porter des lunettes et des gants protectives en
manipulant la cartouche.

Backpressure 

OUTLET
Port

Coil



Setting Up the Eluent Generator

Doc. 031858-03 4/06 45

9. Slide the EluGen cartridge down 
into the holder until it stops. 
Make sure the cable and 
backpressure coil remain out of 
the holder (see Figure 41). 

NOTE To avoid crimping the
lines inside the holder, do
not twist the cartridge
when you slide it into the
holder. The lines are
designed to coil inside the
holder. 

Figure 41. Installing the EluGen Cartridge in the Holder

Die EluGen-Kassette enthält eine korrodierende Base (KOH, LiOH
oder NaOH), eine korrodierende Säure (MSA) oder eine konzentrierte
K2CO3-Lösung. Tragen Sie daher beim Umgang mit Kassette eine
Schutzbrille und Handschuhe.
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10. Remove the plug from 
the EGC-1 connector on 
top of the ICS-2000.

11. Orient the cartridge’s 
blue 4-pin electrical 
cable connector as 
shown in Figure 42. 
Push it onto the EGC-1 
connector on the ICS-
2000. Twist the ring on 
the cable connector 
fingertight to secure it.

Figure 42. Connecting the EluGen Cartridge Cable

Connecting the Vent Line

1. Locate the vent line tubing kit (P/N 063092) supplied with the 
EluGen cartridge. Slide the label onto one end of the tubing and then 
push the barbed luer lock onto the tubing.

2. Unscrew and remove 
the plug from the vent 
opening on the side of 
the EluGen cartridge 
(see Figure 43). 

Figure 43. EluGen Cartridge Vent Plug

Vent Plug
(remove)
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3. Screw the luer adapter 
onto the vent opening. 
Remove the cap on 
the luer adapter by 
twisting. Save the 
cap. 

4. Twist the luer lock 
and EluGen cartridge 
vent line into the luer 
adapter (see 
Figure 44).

Figure 44. Installing the EluGen Cartridge Vent Line

NOTE To prevent leaks from the EluGen cartridge, always 
replace the luer adapter cap before moving the 
EluGen cartridge.

5. Direct the EluGen cartridge vent line to the rear of the ICS-2000 and 
snap it onto one of the tubing clips on the rear panel. 

6. Direct the vent line to the waste container and insert it down into the 
gas separator waste tube about 10 to 15 cm (4 to 6 in).

Recording the EluGen Cartridge Serial Number in Chromeleon 

The serial number is printed on the EluGen cartridge label.

1. Open the Chromeleon Server Configuration program (select Start > 
Programs (or All Programs) > Chromeleon > Server 
Configuration).

2. Double-click the ICS-2000 system icon. The properties dialog box for 
the ICS-2000 appears. 

3. Click the Eluent Generator tab (see Figure 45).

4. Select the EGC-1 check box and enter the EluGen cartridge serial 
number.

5. Click OK.

Luer Adapter

EGC Vent Line

Luer Lock
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Figure 45. Eluent Generator Configuration Properties Example
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Conditioning the EluGen Cartridge

After completing the installation steps described in the previous sections, 
condition the EluGen cartridge for 30 minutes. 

1. Set a temporary waste container, such as a beaker, on top of the 
ICS-2000 and direct the yellow backpressure coil from the EluGen 
cartridge OUTLET port to the container.

2. On the ICS-2000 touch screen HOME page, set the pump flow rate to 
1.00 mL/min. 

3. Touch the EGC button on the HOME page to open the ELUENT 
GENERATOR page. Set the EGC concentration to 50 mM.

4. Verify that the suppressor and CR-TC are off.

5. Verify that the eluent reservoir is filled with ASTM filtered, Type 1 
(18 megohm-cm) deionized water (see Section 11).

6. Turn on the pump.

7. Turn on the EluGen cartridge.

8. Run at the selected settings (1.00 mL/min at 50 mM) for 30 minutes.

9. Turn off the EluGen cartridge.

10. Turn off the pump.

11. Disconnect the EluGen cartridge cable.

12. Remove the backpressure tubing from the waste container and 
remove the waste container.

13. Lift the EluGen cartridge out of the holder, turn it over, and set it in 
the service area. 

To avoid damaging the suppressor and CR-TC, always turn off the
suppressor and CR-TC before conditioning the EluGen cartridge. The
pump flow is on during conditioning, however, no flow reaches the
suppressor or CR-TC.
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14. Disconnect the 
backpressure coil 
from the EluGen 
cartridge OUTLET 
port.

15. Connect the EGC 
OUT line to the 
OUTLET port (see 
Figure 46).

Figure 46. EGC Inlet and Outlet Connections

16. Turn over the EluGen cartridge. Check for bubbles; if necessary, 
shake and tap the EluGen cartridge to remove bubbles.

17. Reinstall the EluGen cartridge in the holder.

18. Do not reconnect the EluGen cartridge cable until after hydrating the 
CR-TC.

Hydrating the CR-TC

Always hydrate the CR-TC before initial operation. This requires running 
ASTM filtered, Type 1 (18 megohm-cm) deionized water through the CR-
TC for 10 minutes, while bypassing the columns and suppressor.

Figure 47 illustrates the liquid flow path through the CR-TC during the 
hydration procedure.
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1. Disconnect the TO INJ VALVE IN - P/ELUENT OUT line from port P (2) 
on the injection valve.

2. Disconnect the TO SRS/AES REGEN OUT line from the suppressor.

3. Use a 10-32 to 1/4-28 coupler (P/N 042806) to connect the TO INJ 
VALVE IN - P/ELUENT OUT line to the SRS/AES REGEN OUT line.

4. Verify that the suppressor is off.

5. without automatically turning onTurn on the pump and set the flow to 
the rate recommended for your application. 

6. Pump deionized water through the CR-TC for at least 10 minutes.

7. Turn off the pump and remove the coupler.

Figure 47. CR-TC Plumbing for Hydration

To avoid damaging the suppressor, always turn off the suppressor
before hydrating the CR-TC. The pump flow is on during conditioning,
however, no flow reaches the suppressor.
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Completing the Eluent Generator Setup

1. Reconnect the TO SRS/AES REGEN OUT line to the REGEN OUT port 
on the suppressor.

2. Reconnect the TO INJ VALVE IN - P/ELUENT OUT line to port P (2) on 
the injection valve.

3. Reconnect the EluGen cartridge cable.

4. Remove the plug from the CR-TC connector on top of the ICS-2000

5. Orient the CR-TC’s 
black 3-pin electrical 
cable connector as 
shown in Figure 42. 
Push it onto the CR-
TC connector on the 
ICS-2000. Twist the 
ring on the cable 
connector and 
fingertighten to 
secure it.

Figure 48. Connecting the CR-TC Cable

NOTE Backpressure tubing may be required between the
injection valve and the EGC degas eluent outlet.
The EluGen cartridge requires 14 to 16 MPa (2000
to 2300 psi) of system backpressure for removal of
electrolysis gas from the eluent produced by the
cartridge. See Section 16.1 for details.

Go on to Section 15.
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14.2 Eluent Generator Setup for Carbonate/Bicarbonate 
Eluent

Follow the instructions in this section if you are installing a K2CO3 
cartridge, an EPM, and an EGC CO3 Mixer (for generating 
carbonate/bicarbonate eluent).

• If you are installing a K2CO3 cartridge and an EGC CO3 Mixer (for 
generating carbonate eluent), go to Section 14.3.

• If you are installing a KOH, LiOH, MSA, or NaOH EluGen cartridge 
and a CR-TC, go to Section 14.1.

Overview

The eluent generator setup procedure for carbonate/bicarbonate eluent 
consists of the following main steps:

• Installing the EluGen cartridge.

• Connecting the EluGen cartridge vent line.

• Installing the EPM.

• Plumbing the EPM for conditioning.

• Recording the EluGen cartridge and the EPM serial numbers in 
Chromeleon.

• Conditioning the EluGen cartridge and the EPM.

• Installing the EGC CO3 Mixer.

• Temporarily filling the EGC CO3 Mixer with deionized water.

• Filling the EGC CO3 Mixer with eluent of the required concentration.

• Completing the eluent generator setup.
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Items Required to Complete the Setup Procedure

The following items are required to setup the EluGen cartridge, EPM, and 
EGC CO3 Mixer. Except as noted, all items are supplied in the ICS-2000 
Ship Kit (P/N 064375).

Item P/N Used To

EPM mounting bracket 063624 Mount the EPM on the EGC holder

35 cm (14 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing 

064340 Lengthen the line between the EGC degas 
eluent inlet and the EPM ELUENT OUT port

30 cm (12 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing

064334 Lengthen the line between the EluGen 
cartridge outlet and the EPM ELUENT IN 
port

28 cm (11 in) of clear 1.58-mm 
(0.062-in) ID Teflon tubing

064337 Lengthen the line between the EGC degas 
regenerant inlet and the EPM REGEN OUT 
port

EluGen Cartridge Vent Line 
Tubing Kit (supplied with the 
cartridge)

063092 Vent the cartridge during operation

Yellow 0.5 mL/min, 7 MPa 
(1000 psi) backpressure coil

053765 Provide backpressure during setup 
procedures

EGC CO3 Mixer mounting clips 063642 Install the mixer

Phillips head screwdriver 
(not supplied)

n/a Install the EGC CO3 Mixer mounting clips

35 cm (14 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing

064346 Connect the EGC degas eluent outlet and the 
EGC CO3 Mixer inlet

60 cm (24 in) of black 0.25-mm 
(0.010-in) ID PEEK tubing

064343 Connect the EGC CO3 Mixer outlet to port P 
(2) on the injection valve

Temporary waste container 
(beaker, bottle, etc.) (not supplied)

n/a Collect waste during setup procedures

10-32 to 10-32 coupler
10-32 to 1/4-28 coupler

042627
042806

Complete the connections

10-32 fittings
10-32 ferrules

043275
043276

Complete the connections

1/8-in fittings
1/8-in ferrules

052267
048949

Complete the connections
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Figure 49 illustrates the EluGen cartridge and EPM after installation.

Figure 49. ICS-2000 with an EluGen Cartridge and EPM Installed

EluGen
Cartridge

(EGC

EGC Holder

EPM



ICS-2000 Ion Chromatography System

56 Doc. 031858-03 4/06

Figure 50 illustrates the liquid flow path through the eluent generator 
components after all setup steps are complete and the eluent generator is 
ready for operation.

Installing the EluGen Cartridge

Figure 50. Eluent Generator Flow Schematic with an EPM and EGC CO3 Mixer:
Use for Generating Carbonate/Bicarbonate Eluent
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1. Tilt the cartridge 
holder to view the 
bottom and brace the 
holder against the back 
corner of the ICS-2000 
(see Figure 51).

Figure 51. Cartridge Holder (tilted to view the bottom)
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2. Use the precut tubing assemblies included in the ICS-2000 Ship Kit 
to extend the length of three lines as described below:

a. Disconnect the TO CR-TC ELUENT IN line (red label) from the 
coupler that connects it to the TO CR-TC ELUENT OUT line (yellow 
label). Connect a 32 to 10-32 coupler to the end of the TO CR-TC 
ELUENT IN line and connect the 30 cm (12 in) length of black 
PEEK tubing (red labels) (P/N 064334) to the coupler (see 
Figure 63).

b. Connect the 35 cm (14 in) length of black PEEK tubing (yellow 
labels) (P/N 064340) to the coupler on the TO CR-TC ELUENT OUT 
line (yellow label).

c. Disconnect the TO CR-TC REGEN IN line (orange label) from the 
coupler that connects it to the TO CR-TC REGEN OUT line (blue 
label). Connect the 28 cm (11 in) length of clear Teflon tubing 
(blue labels) (P/N 064337) to the coupler on the TO CR-TC REGEN 
OUT line (blue label).

Figure 52. EPM Eluent and Regen Line Extensions
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Line (red label) TO CR-TC/EPM 
REGEN OUT 
Line (blue label)



Setting Up the Eluent Generator

Doc. 031858-03 4/06 59

3. Pull the TO CR-TC REGEN IN line (orange label) out of the opening on 
the side of the holder.

4. Thread the three extended lines (red, yellow, and blue labels) through 
the opening on the side of the holder (see Figure 53).

5. Turn the EGC holder right-side up and set it back into position.

6. Orient the EluGen 
cartridge with the fittings 
facing up and remove the 
plugs from the cartridge 
INLET and OUTLET 
fittings (see Figure 54).

Figure 54. EluGen Cartridge Fitting Plugs

Figure 53. TO CR-TC/EPM Lines Outside of Holder
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7. Set the EluGen cartridge in the service area on top of the ICS-2000 
and orient it with the cable toward the EGC holder (see Figure 55).

8. Pull the coiled black EGC IN and EGC OUT lines out from inside the 
EGC holder. Disconnect the EGC IN line from the coupler that 
connects it to the EGC OUT line.

9. Connect the EGC IN 
line to the EluGen 
cartridge INLET port 
(see Figure 80).

10. Remove the coupler 
and connect the EGC 
OUT line to the EluGen 
cartridge OUTLET port.

Figure 56. EluGen Cartridge Inlet and Outlet Port Connections

Figure 55. EluGen Cartridge in Service Area

EGC Cable
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11. Turn the EluGen cartridge over (with the fittings facing down). Shake 
the EluGen cartridge vigorously, and tap it with the palm of your 
hand 10 to 15 times. Check that all bubbles trapped in the eluent 
generation chamber are dislodged. 

12. Slide the EluGen cartridge down into the 
holder until it stops (see Figure 57). Make 
sure the cable remains out of the holder. 

NOTE To avoid crimping the lines, do not
twist the cartridge when you slide it
into the holder. The lines are
designed to coil inside the holder. 

Figure 57. EluGen Cartridge Installed in the Holder

The EluGen cartridge contains one of the following: a corrosive base
(KOH, LiOH, or NaOH), a corrosive acid (MSA), or a concentrated
K2CO3 solution. Wear protective eyewear and gloves when handling
the cartridge.
La cartouche d'EluGen contient un de ce qui suit: une base corrosive
(KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une solution
concentrée de K2CO3. Porter des lunettes et des gants protectives en
manipulant la cartouche.
Die EluGen-Kassette enthält eine korrodierende Base (KOH, LiOH
oder NaOH), eine korrodierende Säure (MSA) oder eine konzentrierte
K2CO3-Lösung. Tragen Sie daher beim Umgang mit Kassette eine
Schutzbrille und Handschuhe.



ICS-2000 Ion Chromatography System

62 Doc. 031858-03 4/06

13. Remove the plug from 
the EGC-1 connector on 
top of the ICS-2000.

14. Orient the cartridge’s 
blue 4-pin electrical 
cable connector as 
shown in Figure 58. 
Push it onto the EGC-1 
connector on the ICS-
2000. Twist the ring on 
the cable connector 
fingertight to secure it.

Figure 58. Connecting the EluGen Cartridge Cable

Connecting the EluGen Cartridge Vent Line

1. Locate the EluGen Cartridge Vent Line Tubing Kit supplied with the 
EluGen cartridge. 

2. Slide the label onto one end of the tubing and then push the barbed 
luer lock onto the tubing.

3. Unscrew and remove 
the plug from the vent 
opening on the side of 
the EluGen cartridge 
(see Figure 59). 

Figure 59. EluGen Cartridge Vent Plug

Vent Plug
(remove)
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4. Screw the luer adapter 
onto the vent opening. 
Remove the cap on 
the luer adapter by 
twisting. Save the 
cap. 

5. Twist the luer lock 
and EluGen cartridge 
vent line into the luer 
adapter (see 
Figure 60).

Figure 60. Installing the EluGen Cartridge Vent Line

NOTE To prevent leaks from the EluGen cartridge,
always replace the luer adapter cap before
moving the EluGen cartridge.

6. Direct the vent line to the waste container and insert it down into the 
gas separator waste tube about 10 to 15 cm (4 to 6 in).

Installing the EPM

1. Remove the plugs from 
the EPM eluent and 
regen liquid ports.

2. Push the EPM onto the 
ball studs on the 
mounting bracket (see 
Figure 61).

Figure 61. EPM and Mounting Bracket

Luer Adapter

EGC Vent Line 

Luer Lock

EGC Cable

Ball Studs

Mounting Bracket

EPM
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3. Lift the EluGen 
cartridge up slightly 
from the EGC holder 
and slide the EPM 
bracket onto the side of 
the holder (see 
Figure 62).

Figure 62. EPM and Mounting Bracket Installed on EGC Holder

4. Connect the following lines to the EPM:

• Connect the TO CR-TC/EPM ELUENT OUT line (yellow label) to 
the ELUENT OUT port on the EPM (see Figure 63).

• Connect the TO CR-TC/EPM ELUENT IN line (red label) to the 
ELUENT IN port on the EPM.

• Connect the TO CR-TC/EPM REGEN IN line (orange label) to the 
REGEN IN port on the EPM.

• Connect the TO CR-TC/EPM REGEN OUT line (blue label) to the 
REGEN OUT port on the EPM.

EGC Cable
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5. Remove the plug from the EGC-2 connector on top of the ICS-2000.

6. Connect the EPM electrical cable to the EGC-2 connector.

Figure 63. EluGen Cartridge and EPM Plumbing with Tubing Extensions
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Recording the EluGen Cartridge and EPM Serial Numbers in 
Chromeleon 

The serial numbers are printed on labels on the EluGen cartridge and 
EPM.

1. Open the Server Configuration program (select Start > Programs (or 
All Programs) > Chromeleon > Server Configuration).

2. Double-click the ICS-2000 system icon. The properties dialog box for 
the ICS-2000 appears. 

3. Click the Eluent Generator tab (see Figure 45).

4. Select the EGC-1 check box and enter the EluGen cartridge serial 
number.

5. Select the EGC-2 check box and enter the serial number of the EPM.

6. Click OK.

Figure 64. Eluent Generator Configuration Properties Example
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Plumbing the EluGen Cartridge and EPM for Conditioning

 Figure 65 illustrates the liquid flow path through the EluGen cartridge 
and EPM during the conditioning procedure.

Figure 65. EluGen Cartridge and EPM Plumbing for Conditioning with 
Carbonate/Bicarbonate Eluent
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1. Disconnect the TO INJ VALVE IN - P/ELUENT OUT line from port P (2) 
on the injection valve. 

2. Use a 10-32 to 10-32 coupler (P/N 042627) to connect the yellow 
0.5 mL/min, 7 MPa (1000 psi) backpressure coil (P/N 053765) to the 
TO INJ VALVE IN - P/ELUENT OUT line.

3. Connect a 10-32 to 1/4-28 coupler (P/N 042806) to the free end of the 
backpressure coil.

4. Disconnect the TO SRS/AES REGEN OUT line from the suppressor 
REGEN OUT port.

5. Connect the TO SRS/AES REGEN OUT line to the 10-32 to 1/4-28 
coupler (see Figure 66).

NOTE The backpressure coil connection in Figure 66 is
temporary; it is required only during the EPM and
EluGen cartridge conditioning procedure described
in the next section.

Figure 66. Backpressure Coil Connections for Conditioning the 
EluGen Cartridge and EPM with Carbonate/Bicarbonate Eluent
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Conditioning the EPM and EluGen Cartridge

After completing the plumbing connections described in the previous 
sections, follow the steps below to hydrate the EPM for 5 minutes and 
then condition the EPM and EluGen cartridge for 30 minutes. 

1. Make sure the eluent reservoir is filled with ASTM filtered, Type I 
(18-megohm) deionized water.

2. Verify that the suppressor is off.

3. On the ICS-2000 touch screen HOME page, set the pump flow rate to 
1.00 mL/min.

4. Turn on the pump.

5. Run the pump for 5 minutes to hydrate the EPM.

6. Touch the EGC button on the HOME page to open the ELUENT 
GENERATOR page. 

7. Verify that the cartridge type for EGC-1 is Carb and the type for EGC-2 
is pH Mod. 

If the cartridge types are wrong, make sure the cartridge serial 
numbers were entered correctly in the Chromeleon Server 
Configuration program (see “Recording the EluGen Cartridge and 
EPM Serial Numbers in Chromeleon” on page 2-66).

8. Select the following settings: 

• Set the EGC-1 concentration to 9 mM. 

• Set the EGC-2 concentration to 1 mM.

9. Turn on the EGC-1 and EGC-2 currents. 

10. Run the EluGen cartridge and EPM at these settings for 30 minutes.

11. Turn off the EGC-1 and EGC-2 current.

12. Turn off the pump.

Installing the EGC CO3 Mixer

To avoid damaging the suppressor, always turn off the suppressor
before conditioning the EPM and EluGen cartridge. The pump flow is
on during conditioning, however, no flow reaches the suppressor.
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Figure 67 illustrates the EGC CO3 Mixer after installation.

Figure 67. ICS-2000 with an EGC CO3 Mixer Installed
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1. Use a Phillips head screwdriver to 
remove the existing small diameter 
mounting clips from the inside of 
the ICS-2000 door.

2. Install the larger diameter clips (P/N 
063642) (see Figure 68).

Figure 68. Location of Mounting Clips for the EGC CO3 Mixer

3. Orient the mixer with the outlet 
pointing upward and push it onto the 
clips (see Figure 69). The mixer 
outlet must point upward to ensure 
thorough mixing of the eluent.

4. Locate the 35 cm (14 in) length of 
black PEEK tubing (white labels) 
(P/N 064346). Connect the end 
labeled TO EGC CO3 MIXER IN to the 
mixer inlet.

5. Locate the 60 cm (24 in) length of 
black PEEK tubing (white labels) 
(P/N 064343). Connect the end 
labeled TO EGC CO3 MIXER OUT to 
the mixer outlet.

Figure 69. EGC CO3 Mixer Installed on the ICS-2000 Door

Mixer
Mounting

Clips

Mixer Inlet

Mixer Outlet
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Filling the EGC CO3 Mixer with Deionized Water

1. Verify that the EGC-1 and EGC-2 currents are off.

2. Disconnect the EluGen cartridge inlet line (labeled TO 
PUMP/DAMPER) from the coupler that connects it to the green pump 
outlet line (see Figure 70).

Figure 70. EluGen Cartridge Inlet and Pump Outlet

TO PUMP/
DAMPER

(disconnect
this line)

Pump Outlet
(green

tubing)
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3. Connect the pump outlet to the mixer inlet (see Figure 71).

4. Direct the mixer outlet line to a temporary waste container, such as a 
beaker.

5. Verify that the suppressor is off.

6. Set the pump flow rate to 5.00 mL/min.

7. Turn on the pump.

8. Run the pump until the mixer is filled and there is a consistent flow of 
water exiting the mixer outlet. 

It takes about 5 minutes to fill a 4-mm mixer and about 2 minutes to 
fill a 2-mm mixer.

9. Turn off the pump.

Figure 71. Pump Outlet Connected to Mixer Inlet for Mixer Hydration

To avoid damaging the suppressor, always turn off the suppressor
before filling the mixer. The pump flow is on during filling, however,
no flow reaches the suppressor.

Mixer Inlet

Pump Outlet
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Filling the EGC CO3 Mixer with the Carbonate/Bicarbonate Eluent

Before initial use, follow the steps in this section to fill the EGC CO3 
Mixer with the carbonate/bicarbonate eluent concentration required for 
the application to be run. 

Figure 72 illustrates the liquid flow path through the eluent generator 
components during initial filling of the EGC CO3 Mixer with 
carbonate/bicarbonate eluent.

Figure 72. EluGen Cartridge and EPM Plumbing for Initial Filling 
of the EGC CO3 Mixer with Carbonate/Bicarbonate Eluent
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1. Disconnect the pump outlet from the mixer inlet.

2. Reconnect the pump outlet and the EluGen cartridge inlet.

3. Connect a 10-32 to 10-32 coupler to the mixer inlet.

4. Disconnect the outlet of the yellow PEEK backpressure coil from the 
TO SRS/AES REGEN OUT line and then connect the backpressure coil 
to the mixer inlet (see Figure 73).

5. Connect the mixer outlet to the TO SRS/AES REGEN OUT line.

NOTE The backpressure coil connection is temporary;
it is required only during initial filling of the
mixer.

6. Verify that the suppressor is off.

Figure 73. Mixer Connected Directly to Eluent 
Generator Outlet for Initial Filling
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7. Set the pump flow rate to the rate required for the application.

8. Turn on the pump.

9. Verify that the system backpressure is between 14 and 16 MPa (2000 
and 2300 psi). If necessary, adjust the pressure by adding or removing 
backpressure tubing.

10. Set the EGC-1 and EGC-2 concentrations to the values required for 
your application. For example, for a 3.5 mM K2CO3/1.0 mM KHCO3 
mixture, set the EGC-1 concentration to 3.5 mM and the EGC-2 
concentration to 1.0 mM.

11. Turn on the EGC-1 and EGC-2 currents.

12. Run at the selected settings until the mixer is filled with the eluent 
mixture. At a flow rate of 1 mL/min it will take about 45 minutes to 
fill the 4-mm mixer and about 15 minutes to fill the 2-mm mixer.

NOTE The void volume of the 4-mm mixer is about
16 mL. The void volume of the 2-mm mixer is
about 5 mL. 

13. Turn off the EGC-1 and EGC-2 currents.

14. Turn off the pump.

15. Remove the yellow PEEK backpressure coil from the TO INJ VALVE 
IN - P/ELUENT OUT line and the mixer inlet.

16. Disconnect the mixer outlet from the TO SRS/AES REGEN OUT line 
and remove the 10-32 to 1/4-28 coupler.

17. Reconnect the TO SRS/AES REGEN OUT line to the suppressor REGEN 
OUT port.

To avoid damaging the suppressor, always turn off the suppressor
before filling the mixer. The pump flow is on during filling, however,
no flow reaches the suppressor.
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Completing the Eluent Generator Setup for Carbonate/Bicarbonate 
Eluent

Figure 74 illustrates the liquid flow path through the ICS-2000 after all 
setup steps are complete and the eluent generator is ready for operation.

Figure 74. ICS-2000 Flow Schematic: Carbonate/Bicarbonate Eluent Generation
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1. Connect the TO INJ VALVE IN - P/ELUENT OUT line to the coupler 
attached to the mixer inlet line. Route this line along the back of the 
drip tray to prevent it from being pinched when the ICS-2000 door is 
opened and closed

2. Route the mixer outlet line to the back of the component panel (see 
Figure 75).

3. Connect the mixer outlet line to port P (2) on the injection valve. 

NOTE Backpressure tubing may be required between the
injection valve and the EGC CO3 Mixer outlet. The
EluGen cartridge requires 14 to 16 MPa (2000 to
2300 psi) of system backpressure for removal of
electrolysis gas from the eluent produced by the
cartridge. See Section 16.1 for details.

Go on to Section 15.

Figure 75. Mixer Outlet Routed to the Back of the Component Panel 
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14.3 Eluent Generator Setup for Carbonate Eluent

Follow the instructions in this section if you are installing a K2CO3 
cartridge and an EGC CO3 Mixer (for generating carbonate eluent).

• If you are installing a KOH, LiOH, MSA, or NaOH EluGen cartridge 
and a CR-TC, go to Section 14.1.

• If you are installing a K2CO3 cartridge, an EPM, and an EGC CO3 
Mixer (for generating carbonate/bicarbonate eluent), go to 
Section 14.2.

Overview

The eluent generator setup procedure for carbonate eluent consists of the 
following main steps:

• Installing the EluGen cartridge and preparing for conditioning.

• Conditioning the EluGen cartridge.

• Installing the EGC CO3 Mixer.

• Filling the EGC CO3 Mixer with the eluent concentration required for 
the application.

• Completing the eluent generator setup.
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Items Required to Complete the Setup Procedure

In addition to the EluGen cartridge and the EGC CO3 Mixer, you will 
need the following items to complete the eluent generator setup. Except 
as noted, all items are supplied in the ICS-2000 Ship Kit (P/N 064375).

Item P/N Use To

Yellow 0.5 mL/min, 7 MPa 
(1000 psi) backpressure coil

053765 Provide backpressure during 
setup procedures

EluGen Cartridge Vent Line 
Tubing Kit (supplied with the 
cartridge)

063092 Vent the cartridge during 
operation

EGC CO3 Mixer mounting 
clips

063642 Install the mixer

Phillips head screwdriver (not 
supplied)

n/a Install the EGC CO3 Mixer 
mounting clips

35 cm (14 in) of black 
0.25-mm (0.010-in) ID PEEK 
tubing

064346 Connect the EGC degas eluent 
outlet and the EGC CO3 Mixer 
inlet

60 cm (24 in) of black 
0.25-mm (0.010-in) ID PEEK 
tubing

064343 Connect the EGC CO3 Mixer 
outlet to port P (2) on the 
injection valve

Temporary waste container 
(beaker, bottle, etc.) (not 
supplied)

n/a Collect waste during setup 
procedures

10-32 fittings
10-32 ferrules

043275
043276

Complete the plumbing 
connections

1/8-in fittings
1/8-in ferrules

052267
048949

Complete the plumbing 
connections

10-32 to 10-32 couplers 042627 Complete the plumbing 
connections
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Figure 76 illustrates the liquid flow path through the eluent generator 
components after all setup steps are complete and the eluent generator is 
ready for operation.

Figure 76. Eluent Generator Flow Schematic with an EGC CO3 Mixer:
Use for Generating Carbonate Eluent
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Installing the EluGen Cartridge and Preparing for Conditioning

Follow the steps in this section to install the EluGen cartridge and prepare 
it for conditioning before initial use.

Figure 77 illustrates the liquid flow path during the conditioning 
procedure.

Figure 77. EluGen Cartridge Plumbing for Conditioning with Carbonate Eluent
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1. Orient the EluGen 
cartridge with the fittings 
facing up and remove the 
plugs from the cartridge 
INLET and OUTLET 
fittings (see Figure 54).

Figure 78. EluGen Cartridge Fitting Plugs

2. Set the EluGen cartridge in the service area on top of the ICS-2000 
and orient it with the cable toward the EGC holder (see Figure 79).

Figure 79. EluGen Cartridge in Service Area

OUTLET

INLET

EGC Cable
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3. Pull the coiled black EGC IN and EGC OUT lines out from inside the 
EGC holder. Disconnect the EGC IN line from the coupler that 
connects it to the EGC OUT line.

4. Connect the EGC IN 
line to the EluGen 
cartridge INLET port 
(see Figure 80).

5. Remove the coupler 
and connect the EGC 
OUT line to the EluGen 
cartridge OUTLET port.

Figure 80. EluGen Cartridge Port Connections

6. Turn the EluGen cartridge over (with the fittings facing down). Shake 
the EluGen cartridge vigorously, and tap it with the palm of your 
hand 10 to 15 times. Check that all bubbles trapped in the eluent 
generation chamber are dislodged. 

The EluGen cartridge contains one of the following: a corrosive base
(KOH, LiOH, or NaOH), a corrosive acid (MSA), or a concentrated
K2CO3 solution. Wear protective eyewear and gloves when handling
the cartridge.
La cartouche d'EluGen contient un de ce qui suit: une base corrosive
(KOH, LiOH, ou NaOH), un acide corrosif (MSA), ou une solution
concentrée de K2CO3. Porter des lunettes et des gants protectives en
manipulant la cartouche.
Die EluGen-Kassette enthält eine korrodierende Base (KOH, LiOH
oder NaOH), eine korrodierende Säure (MSA) oder eine konzentrierte
K2CO3-Lösung. Tragen Sie daher beim Umgang mit Kassette eine
Schutzbrille und Handschuhe.
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7. Slide the EluGen cartridge down into the 
holder until it stops (see Figure 81). Make 
sure the cable remains out of the holder. 

NOTE To avoid crimping the lines, do not
twist the cartridge when you slide
it into the holder. The lines are
designed to coil inside the holder. 

Figure 81. EluGen Cartridge Installed in the Holder

8. Remove the plug from 
the EGC-1 connector on 
top of the ICS-2000.

9. Orient the cartridge’s 
blue 4-pin electrical 
cable connector as 
shown in Figure 82. 
Push it onto the EGC-1 
connector on the ICS-
2000. Twist the ring on 
the cable connector 
fingertight to secure it.

Figure 82. Connecting the EluGen Cartridge Cable
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10. Disconnect the TO INJ VALVE IN - P/ELUENT OUT line from port P (2) 
on the injection valve. 

11. Use a 10-32 to 10-32 coupler (P/N 042627) to connect the TO INJ 
VALVE IN - P/ELUENT OUT line to one end of the yellow 0.5 mL/min, 
7 MPa (1000 psi) backpressure coil (P/N 053765) (see Figure 83).

12. Direct the free end of the backpressure coil to a temporary waste 
container.

Figure 83. Plumbing Connections for Conditioning the 
EluGen Cartridge with Carbonate Eluent
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Installing the EluGen Cartridge Vent Line

1. Locate the EluGen Cartridge Vent Line Tubing Kit 
(P/N 063092) supplied with the EluGen cartridge. 

2. Slide the label onto one end of the tubing and then push the barbed 
luer lock onto the tubing.

3. Unscrew and remove 
the plug from the vent 
opening on the side of 
the EluGen cartridge 
(see Figure 84). 

Figure 84. EluGen Cartridge Vent Plug

4. Screw the luer adapter 
onto the vent opening. 
Remove the cap on 
the luer adapter by 
twisting. Save the 
cap. 

5. Twist the luer lock 
and EluGen cartridge 
vent line into the luer 
adapter (see 
Figure 85).

Figure 85. Installing the EluGen Cartridge Vent Line

NOTE To prevent leaks from the EluGen cartridge, always 
replace the luer adapter cap before moving the 
EluGen cartridge.

6. Direct the EluGen cartridge vent line to the rear of the ICS-2000 and 
snap it onto one of the tubing clips on the rear panel. 

Vent Plug
(remove)

Luer Adapter

EGC 
Vent Line

Luer Lock
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7. Direct the vent line to the waste container and insert it down into the 
gas separator waste tube about 10 to 15 cm (4 to 6 in).

Recording the EluGen Cartridge Serial Number in Chromeleon 

The serial number is printed on the EluGen cartridge label.

1. Open the Chromeleon Server Configuration program (select 
Start>Programs (or All Programs)>Chromeleon>Server 
Configuration).

2. Double-click the ICS-2000 system icon. The properties dialog box for 
the ICS-2000 appears. 

3. Click the Eluent Generator tab (see Figure 86).

4. Select the EGC-1 check box.

5. Enter the EluGen cartridge serial number and click OK.

Figure 86. Eluent Generator Configuration Properties Example
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Conditioning the EluGen Cartridge

After completing the installation steps described in the previous sections, 
condition the EluGen cartridge for 30 minutes before initial use. 

1. Make sure the eluent reservoir is filled with ASTM filtered, Type I 
(18-megohm) deionized water.

2. Verify that the suppressor is off.

3. On the ICS-2000 touch screen HOME page, set the pump flow rate to 
1.00 mL/min.

4. Turn on the pump.

5. On the touch screen HOME page, touch the EGC button to open the 
ELUENT GENERATOR page. Verify that the cartridge type is Carb. 

If the cartridge type is wrong, verify that the cartridge serial number 
was entered correctly in the Chromeleon Server Configuration 
program (see “Recording the EluGen Cartridge Serial Number in 
Chromeleon” on page 2-88).

6. Set the EGC-1 concentration to 9 mM.

7. Turn on the EGC-1 current. 

8. Run the EluGen cartridge at these settings for 30 minutes.

9. Turn off the EGC-1 current.

10. Turn off the pump.

Installing the EGC CO3 Mixer

To avoid damaging the suppressor, always turn off the suppressor
before conditioning the EluGen cartridge. The pump flow is on during
conditioning, however, no flow reaches the suppressor.
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Figure 67 illustrates the EGC CO3 Mixer after installation.

Figure 87. ICS-2000 with an EGC CO3 Mixer Installed

TO EGC CO3
MIXER IN

(P/N 064346)

TO EGC CO3
MIXER OUT

(P/N 064343)
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1. Use a Phillips head screwdriver to 
remove the existing small diameter 
mounting clips from the inside of 
the ICS-2000 door.

2. Install the larger diameter mounting 
clips (P/N 063642) (see Figure 88).

Figure 88. Location of Mounting Clips for the EGC CO3
Mixer

3. Orient the mixer with the outlet 
pointing upward and push it onto the 
clips (see Figure 89). The mixer 
outlet must point upward to ensure 
thorough mixing of the eluent.

4. Locate the 35 cm (14 in) length of 
black PEEK tubing (white labels) 
(P/N 064346). Connect the end 
labeled TO EGC CO3 MIXER IN to the 
mixer inlet.

5. Locate the 60 cm (24 in) length of 
black PEEK tubing (white labels) 
(P/N 064343). Connect the end 
labeled TO EGC CO3 MIXER OUT to 
the mixer outlet.

Figure 89. EGC CO3 Mixer Installed on the ICS-2000 Door
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Filling the EGC CO3 Mixer with the Carbonate Eluent

Before initial use, follow the steps in this section to fill the EGC CO3 
Mixer with the carbonate eluent required for the application to be run. 
Figure 90 illustrates the liquid flow path through the eluent generator 
components during initial filling of the EGC CO3 Mixer with carbonate 
eluent.

Figure 90. Plumbing for Filling the EGC CO3 Mixer with Carbonate Eluent
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1. Connect a 10-32 to 10-32 coupler to the mixer inlet and connect the 
outlet of the yellow PEEK backpressure coil to the coupler.

2. Direct the mixer outlet to the temporary waste container.

3. Verify that the suppressor is off.

4. Verify that the Automatically turn on with pump option is not 
selected on the ICS-2000 touch screen SUPPRESSOR page (see 
Section C.9). Disabling this option lets you turn on the pump, without 
automatically turning on the suppressor.

5. Set the pump flow rate to the rate required for the application.

6. Turn on the pump.

7. Verify that the system backpressure is between 14 and 16 MPa (2000 
and 2300 psi). If necessary, adjust the pressure by adding or removing 
backpressure tubing.

8. Set the EGC-1 concentration to the value required for your 
application. 

9. Turn on the EGC-1 current.

10. Run at these settings until a consistent flow of eluent is exiting the 
mixer outlet. At a flow rate of 1 mL/min it will take about 16 minutes 
to fill a 4-mm mixer and about 5 minutes to fill a 2-mm mixer.

NOTE The void volume of the 4-mm mixer is about
16 mL. The void volume of the 2-mm mixer is
about 5 mL. 

11. Turn off the EGC-1 current.

12. Turn off the pump.

13. Remove the yellow PEEK backpressure coil from the TO INJ VALVE 
IN - P/ELUENT OUT line and the mixer inlet.

14. Retain the coupler on the mixer inlet.

To avoid damaging the suppressor and CR-TC, always turn off the
suppressor before conditioning the EluGen cartridge. The pump flow
is on during conditioning, however, no flow reaches the suppressor.
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Completing the Eluent Generator Setup for Carbonate Eluent

Figure 91 illustrates the liquid flow path through the ICS-2000 after all 
setup steps are complete and the eluent generator is ready for operation.

Figure 91. ICS-2000 Flow Schematic: Carbonate Eluent Generation
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1. Connect the TO INJ VALVE IN - P/ELUENT OUT line to the coupler 
attached to the mixer inlet line. Route this line along the back of the 
drip tray to prevent it from being pinched when the ICS-2000 door is 
opened and closed.

2. Route the mixer outlet line to the back of the component panel (see 
Figure 92).

3. Connect the mixer outlet line to port P (2) on the injection valve. 

NOTE Backpressure tubing may be required between the
injection valve and the EGC CO3 Mixer outlet. The
EluGen cartridge requires 14 to 16 MPa (2000 to
2300 psi) of system backpressure for removal of
electrolysis gas from the eluent produced by the
cartridge. See Section 16.1 for details.

Go on to Section 15.

Figure 92. Mixer Outlet Routed to the Back of the Component Panel 
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15 Setting Up a Chromeleon Application

Chromeleon provides application templates that let you quickly get started 
running. To use the application templates, you need to know the type of column 
and suppressor you will be using. This section shows how to create a sequence (a 
list of samples to be processed) and how to use an application template.

1. Identify the type of column and suppressor installed in the ICS-2000.

2. Start Chromeleon (select Start>Programs>Chromeleon>Chromeleon). 
The Chromeleon main window and Browser appear (see Figure 93).

Figure 93. Chromeleon Main Window and Browser
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3. In the Browser, select File>New and select Sequence (using Wizard) (see 
Figure 94).

The Sequence Wizard Welcome page appears (see Figure ).

Figure 94. Creating a New Sequence

Figure 95. Sequence Wizard Welcome Page
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NOTE For details about a Sequence Wizard step, click the Help
button on the Sequence Wizard page.

4. Click Next>.

The Sequence Wizard Timebase page appears (see Figure 96). 

Figure 96. Example: Sequence Wizard Step 1

5. Select the ICS-2000 timebase and click Next>.
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The Unknown Samples page appears (see Figure 97). 

6. Select Use Template from the drop-down list. 

7. In the Template for Sample Name field, type Sample, click the right arrow, 
and select Sample Number #n. 

8. In the Number of Vials field, type 1.

9. Use default settings for the remaining parameters on the page.

NOTE You can edit the sequence later, to add more samples
and select the injection parameters appropriate for your
application.

Figure 97. Example: Sequence Wizard Step 2
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10. Click Apply>>. 

Figure 98 shows Sequence Wizard Step 2 after a sample is defined.

Figure 98. Example: Sequence Wizard Step 2 with Sample Defined 

11. Click Next>. 
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The Standard Samples page appears (see Figure 99). 

Figure 99. Example Sequence Wizard Step 3 

12. Click Next> to omit this step and define standard injections later. Or, define 
one or more standard injections, and then click Next>. 

The Methods & Reporting page appears.
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13. Select the Use Application Template check box.

14. From the drop-down lists, select the type of suppressor to be installed and 
then select the column. 

In the example in Figure 100, the 4-mm ASRS suppressor and AS17 column 
are selected.

Figure 100. Example: Sequence Wizard Step 4 

15. To select a report template, click the Browse button, go to the Dionex 
Templates/Reports folder, and select a template (for example, default).

16. Click Next>. 

The Saving the Sequence page appears.
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17. Enter a name for the sequence and a location (see the example in Figure 101). 

Figure 101. Example: Sequence Wizard Step 5 

18. Click Finish> and then click Done on the last page of the Sequence Wizard.
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The Browser appears, displaying the sequence you created (see Figure 102). 
Notice the three files in the top pane of the Browser window. 

Figure 102. Example Browser with Open Sequence

• The .pgm file (program) contains commands and parameters for 
controlling the ICS-2000, controlling the autosampler (if used), and 
acquiring sample data. 

• The .qnt file (quantification method) contains peak identification and area 
determination parameters.

• The .pan file (Control panel) lets you control and/or monitor the ICS-
2000 and other modules that are connected to the timebase. 

NOTE The sequence that you create here is intended as a
starting point only. You can add additional samples to
the sequence, change injection parameters, and edit the
.pgm and .qnt files. Refer to the Chromeleon online Help
for details. 

NOTE After completing the installation, see Chapter 3 in the
ICS-2000 operator’s manual (Document No. 031857) for
how to process the samples and standards in the
sequence. The manual is on the Dionex Reference
Library CD-ROM (P/N 053891).
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19. Double-click the .pan file to open the Control panel for your system (see the 
example in Figure 103).

Figure 103. ICS-2000 System Control Panel Example

NOTE If the Connected check box is not selected, click the box
to connect the ICS-2000 to the Control panel.

15.1 Verifying Chromeleon Communication

Verify that Chromeleon is communicating with the ICS-2000 by clicking 
the Inject and then the Load button on the Control panel. If 
communication is occurring, you will hear the valve actuate as it changes 
position. Go on to Section 12.
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16 Equilibrating the System

1. After priming the pump, turn on the pump and set the flow to the operating 
rate.

2. Flush the system for about 5 minutes to equilibrate.

3. Monitor the system pressure reading from the Chromeleon Control panel. 

The EluGen cartridge requires at least 14 MPa (2000 psi) of system 
backpressure for removal of electrolysis gas from the eluent produced by the 
cartridge. A system backpressure of 16 MPa (2300 psi) is ideal. If the pressure 
is too low, install a backpressure coil (see Section 16.1). 

4. Check that liquid is flowing out of the suppressor REGEN OUT waste line and 
that the pressure is stable.

5. Monitor the baseline conductivity. In general, it should be <30 µS for a system 
set up for anion analyses, and <2 µS for a system set up for cation analyses. 
Equilibration time varies and it can take some time to reach these expected 
values.

6. Go on to Section 17.

The recommended maximum operating pressure for the eluent
generator is 21 MPA (3000 psi). Excessive backpressure may rupture
the tubing in the EGC degas tubing assembly.
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16.1 EluGen Cartridge Backpressure Requirements

The EluGen cartridge requires at least 14 MPa (2000 psi) of backpressure 
for optimal removal of electrolysis gas from the eluent produced by the 
cartridge. During system equilibration (see Section 16), monitor the 
system pressure and verify that it is between 14 and 20 MPa (2000 and 
3000 psi). A system backpressure of 16 MPa (2300 psi) is ideal. 

If the pressure is too low, install a backpressure coil between the injection 
valve and the eluent outlet. The backpressure coils listed in the table 
below are included in the ICS-2000 Ship Kit (P/N 064375). 

Connect one end of the backpressure coil to port P (2) on the injection 
valve; connect the other end to the TO INJ VALVE IN - P/ELUENT OUT line 
or to the mixer outlet, if an EGC CO3 Mixer is installed. 

17 Verifying Operational Status

After the system has equilibrated, verify the actual pump pressure and stability by 
monitoring the pump pressure reading on the Chromeleon Control panel (or the 
touch screen HOME page). Write down the short-term pressure fluctuations; they 
should be less than 0.13 MPa (20 psi).

Part Number Description Flow Rate Approximate Back-
pressure Added

053763 4-mm Backpressure Coil 2.00 mL/min 7 MPa (1000 psi)
(red) 1.00 mL/min 3.5 MPa (500 psi)

053762 4-mm Backpressure Coil 2.00 mL/min 3.5 MPa (500 psi)
(red) 1.00 mL/min 1.75 MPa (250 psi)

053765 2-mm Backpressure Coil 0.50 mL/min 7 MPa (1000 psi)
(yellow) 0.25 mL/min 3.5 MPa (500 psi)

053764 2-mm Backpressure Coil 0.50 mL/min 3.5 MPa (500 psi)
(yellow) 0.25 mL/min 1.75 MPa (250 psi)
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18 Connecting an AS or AS50 (USB) Autosampler 
(Optional)

To use an AS or AS50 (USB) autosampler with the ICS-2000, the following 
requirements must be met:

• The ICS-2000 injection valve must be linked to the AS or AS50 (USB) in the 
Chromeleon timebase (see Section 18.2)

• An injection valve should not be installed in the AS or AS50 (USB) (see the 
note below)

After the AS or AS50 (USB) is connected to the ICS-2000 and the valve is linked 
in Chromeleon, all autosampler injection valve commands will control the ICS-
2000 injection valve (whether issued from the AS or AS50 (USB) front panel or 
from Chromeleon). In addition, all AS or AS50 (USB) modes of injection (full-
loop, partial-loop, partial-loop limited-sample, and others) are supported.

NOTE Dionex recommends using AS or AS50 (USB) models
that do not have injection valves (see the list below). If a
valve is installed in the autosampler, it is switched at the
same time as the valve in the ICS-2000. This causes
unnecessary wear on the autosampler valve. If required,
the autosampler valve can be disconnected from the AS
or AS50 (USB) electronics. If you wish to do this, contact
Dionex for assistance. The AS or AS50 (USB) electronics
components cannot be serviced by the user. 

The following AS50 (USB) and AS models can be used with an ICS-2000:

Part 
Number

Autosampler 
Model

Injection 
Valve

Sample 
Preparation

Sample Tray 
Cooling

061130 AS50 (USB) No No Yes
061132 AS50 (USB) No Yes Yes
061134 AS50 (USB) No No No
061136 AS50 (USB) No Yes No
063102 AS No No No
063103 AS No Yes No
063106 AS No No Yes
063107 AS No Yes Yes
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NOTE The ICS-2000 and the AS or AS50 (USB) can be set up
for stand-alone (front-panel) operation. This requires a
TTL cable connection between the AS or AS50 (USB)
and the ICS-2000. See the TTL appendix in the ICS-
2000 operator’s manual for stand-alone setup
instructions.

18.1 AS or AS50 (USB) Connections

1. Place the autosampler to the left of the ICS-2000 on the workbench. 

2. Open the ICS-2000 and autosampler doors.

3. The needle seal line that extends from the inject port in the 
autosampler is coiled inside the autosampler door, on the right side. 
Route this line through the autosampler right side slot (see 
Figure 104) and the ICS-2000 left side slot to the ICS-2000 injection 
valve.

The needle seal line from the autosampler inject port to the ICS-2000
injection valve is calibrated for use with the ICS-2000. To ensure
injection precision, do not shorten (by cutting) or lengthen this line, or
replace it with a different (uncalibrated) line. 

Figure 104. Autosampler Drip Tray

Insert the waste 
line from the ICS-
2000 injection 
valve here

Route autosampler 
needle seal line to 
ICS-2000 injection 
valve 
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4. Connect the needle seal line 
from the autosampler to 
port S (5) on the injection 
valve (see Figure 105).

The green waste line that is 
connected to port W (6) on 
the injection valve (see 
Figure 105) is connected 
with a coupler to a Teflon 
waste line (see Figure 106) 
and routed through the 
tubing chase to the ICS-
2000 rear panel.

Figure 105. ICS-2000 Injection Valve

5. Disconnect the green waste 
line (labeled AS/AS50 
TRAY) from the coupler and 
route the line to the drip 
tray in the autosampler 
compartment.

You can either leave the 
disconnected Teflon waste 
line and coupler in the 
tubing chase, or pull the 
line out from the front.

Figure 106. Injection Valve Waste Line Coupler

6. Push the end of the green AS/AS50 TRAY line into the small round opening on 
the right side of the AS or AS50 (USB) tray (see Figure 104).

NOTE Bend the waste line tubing about 5-mm from the end to
ensure it stays in place in the opening in the drip tray.
When bending the tubing, be sure not to restrict the
inner diameter.

Make sure the injection valve waste line is not elevated above the
injection valve at any point between the valve and the autosampler
drip tray. 

Autosampler
Needle Seal

Line

Waste
Line

Coupler

Tubing
Chase

Teflon
Waste
Line

AS/AS50 TRAY 
Waste Line 
(disconnect from 
coupler)
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18.2 AS or AS50 (USB) Chromeleon Setup

1. If you have not already done so, add the autosampler to the 
Chromeleon timebase (see Section 8).

2. In the ICS-2000 Server Configuration properties, verify that the 
injection valve is controlled by the autosampler. To do this:

a. Open the Chromeleon Server Configuration program and select 
the ICS-2000 device in the timebase. 

b. Select Properties on the Edit menu.

c. Select the Inject Valve tab. 

d. Verify that the Pump_InjectValve check box is selected and that 
AS is listed in the Controlled By column (see Figure 107). 

e. If ICS-2000 is listed in the Controlled By column, select the 
Pump_InjectValve name and press the F2 key. A dialog box 
appears. Select AS in the Controlled by drop-down list.

Figure 107. ICS-2000 Inject Valve Server Configuration Properties



ICS-2000 Ion Chromatography System

112 Doc. 031858-03 4/06

19 Connecting an AS40 Automated Sampler (Optional)

1. Place the AS40 to the left 
of the ICS-2000 on the 
workbench. 

2. Open the front door of the 
ICS-2000 and thread the 
outlet line from the AS40 
through the left side slot 
at the front of the ICS-
2000.

3. Connect the outlet line 
from the AS40 to port 
S (5) of the injection valve 
(see Figure 108).

Figure 108. ICS-2000 Injection Valve

4. Locate the relay control cable (P/N 047946) supplied with the AS40.

5. Remove the 2-position connector plug from the pair of wires labeled LOAD on 
the relay control cable.

6. Locate the 12-position connector 
plug (P/N 923686) in the ICS-
2000 Ship Kit (P/N 064375) (see 
Figure 109).

7. Attach the red wire from the 
relay control cable to position 1 
on the plug, and attach the green 
wire to position 2. This will be 
used to connect the AS40 LOAD 
relay to RELAY OUT 1 on the 
ICS-2000.

To attach a wire to the plug, strip the end of the wire, insert it into the plug, 
and use a screwdriver to tighten the locking screw.

When attaching wires to the connector plug, be careful not to allow
stray strands of wire to short to the adjoining position on the
connector.

AS40
Sample

Outlet Line

Figure 109. 12-Position Connector Plug

Position 1

Position 12

Locking 
Screws



Connecting an AS40 Automated Sampler (Optional)

Doc. 031858-03 4/06 113

NOTE If RELAY OUT 1 is not available, you can connect to
RELAY OUT 2 or to one of the TTL outputs. For RELAY
OUT 2, connect the red wire to position 3 and the green
wire to position 4. For TTL OUT 1, connect the red wire
to position 5 and the green wire to position 11. For TTL
OUT 2, connect the red wire to position 6 and the green
wire to position 12. 

8. Connect the relay control cable's 10-position connector plug to the RELAY 
CONTROL connector on the AS40 rear panel (see Figure 110).

9. Plug the 12-position connector plug into the TTL and relay connector on the 
ICS-2000 rear panel (see Figure 110). Make sure the red wire connects to 
position 1 and the green wire connects to position 2.

The AS40 Load relay is now dedicated to the ICS-2000 RELAY OUT 1. Use this 
relay for running with Chromeleon. When you set up the ICS-2000 application 
(see Section 15), commands for controlling the AS40 Load relay and switching 

Figure 110. Example AS40 Autosampler Connection
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the ICS-2000 injection valve are included by default in the program file (see 
Figure 111). 

Figure 111. Example Program for AS40 Control

20 Connecting the Analog Output (Optional)

The analog output connector on the ICS-2000 rear panel outputs an analog voltage 
signal proportional to the conductivity measured by the cell. The selected data rise 
time filters the output. The analog output can be connected to an analog-to-digital 
converter such as an integrator or other recording device. Refer to the 
documentation for the device for connection instructions. 

Analog output is 0 to 1V, scaled to the selected range.

For an example setup for ICS-2000 stand-alone operation with an AS or AS50 
(USB) autosampler, see the TTL appendix in the ICS-2000 operator’s manual.

21 Pressurizing the Eluent Reservoir (Optional)

The ICS-2000 does not require pressurized reservoirs. However, if eluent is 
manually degassed or is sensitive to contamination, Dionex recommends 
pressurizing the reservoir with helium or nitrogen. The air regulator accessory 
bracket and other items needed for pressurizing the eluent reservoir must be 
ordered separately (P/N 060054).

Relay 1 turned on to start 
the AS40 Load cycle and 

Relay 1 turned off after 
 

 load the sample loop 
138 seconds

Injection valve
 switched to Inject 

Injection valve
 switched back
to Load
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21.1 Connect the Gas Source

1. Locate the barbed fitting (P/N 030071), pipe thread reducer 
(P/N 030087), 3-mm (1/8-in) ID tubing (P/N 040793), and ICS-2000 
air regulator accessory (P/N 060054). These parts must be ordered 
separately.

2. Use the barbed fitting and pipe thread reducer to connect the 3-mm 
(1/8-in) ID tubing to a clean gas source, regulated to between 0.55 
and 0.83 MPa (80 and 120 psi).

3. Push the other end of the tubing onto the inlet of the air regulator (see 
Figure 112).

4. Remove the eluent reservoir cap.

5. Connect the gas line from the eluent reservoir cap to the gas line on 
the air regulator outlet.s

6. Slip the air regulator accessory bracket over the neck of the eluent 
reservoir (see Figure 112). 

Figure 112. ICS-2000 Pressurized Eluent Reservoir Connections (Optional)

Gas Inlet Line 
3-mm (1/8-in) ID

Connect to 
gas source

Eluent Gas Line

Air Regulator 
Accessory 
Bracket
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21.2 Pressurize the Eluent Reservoir

NOTE Do not pressurize the ICS-2000 until after the
reservoir is plumbed.

1. Pull out the air regulator knob and turn it fully counterclockwise to 
ensure there is no pressure to the reservoir when the gas source is 
turned on. 

2. Turn on the gas source.

3. Pull out the air regulator knob and turn it clockwise to pressurize the 
eluent reservoir. 

4. Adjust the pressure to between 0.03 and 0.04 MPa (5 and 6 psi). Push 
the regulator knob back in. 

Do not pressurize the eluent reservoir above 0.07 MPa (10 psi).

Ne mettez jamais les réservoirs d'éluants sous une pression
supérieure à 0,07 MPa (10 lb/po²).

Setzen Sie den Eluentbehälter auf keinen Fall einem Druck über 0,07
MPa aus. 
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22 Pump Continuous Seal Wash Connections (Optional)

The pump includes a seal wash assembly that can be set up to continuously rinse 
the back of the piston seals to remove salt crystals and prolong the life of the seals. 
Follow the steps below to set up this feature.

1. Fill a flush bottle with either deionized water or a combination of deionized 
water and 10% or 20% isopropyl alcohol. (Isopropyl alcohol will inhibit 
bacterial growth in the water.)

2. Place the flush bottle on top of the ICS-2000. During operation, gravity 
maintains flow through the pump heads.

3. The flush solution is carried to the piston seal wash assembly and out to waste 
via 1.5-mm (0.06-in) ID tubing (P/N 055847). Locate this tubing in the ICS-
2000 Ship Kit (P/N 064375)and cut the tubing into three unequal pieces in the 
following lengths:

• 117 cm (46 in)

• 152 cm (60 in)

• 15 cm (6 in)

4. Install the tubing as follows (see Figure 113 and Figure 114):

a. Push the 117-cm (46-in) piece of clear tubing onto the drain tube on the 
bottom of the secondary pump head. Place the free end of this tubing in 
the flush bottle. Make sure the end of the tubing is near the bottom of the 
bottle.

Figure 113. Primary and Secondary Pump Heads with Drain Tubes

Secondary
Pump Head

Primary Pump 
Head

Drain Tube

Drain Tube

Note: The drain 
tubes on the 
bottom of each 
pump head are not 
visible in the 
photo.
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b. Push the 152-cm (60-in) piece of clear tubing onto the drain tube on the 
top of the primary pump head. This is the waste line. Route this waste line 
through the lower tubing chase and out the back of the ICS-2000.

c. Push the 15-cm (6-in) piece of clear tubing over the drain tube on the top 
the secondary pump head. Push the other end of the tubing over the drain 
tube on the bottom of the primary pump head.

d. Place a 10 mL syringe (P/N 054578) at the end of the waste line, press the 
syringe against the line to form a seal, and draw out all of the air.

e. Push approximately 5 cm (2 in) of black 0.25-mm (0.01-in) ID tubing 
(P/N 057057) into the end of the waste line. 

NOTE The black tubing creates a flow restriction. Assuming a
height difference of about 76 cm (30 in) between the
flush bottle and the waste container, this setup provides
a flow of one drop of flush solution every 5 to 30 seconds. 

f. Place the end of the waste line in a waste container.

g. This completes the piston seal wash installation. Periodically refill the 
flush bottle and empty the waste container as required.

Figure 114. Piston Seal Wash Flow Schematic

Flush
Bottle

Waste
Container

Insert black tubing into
end of waste line
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Primary Pump Head

Secondary Pump Head
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23 Manually Connecting to a Control Panel

This section describes how to manually connect the ICS-2000 to a Control panel if 
you do not use the application templates described in Section 15.

1. In the Browser, expand the Dionex Templates\Panels\Dionex_IC\ICS-2000 
System Panels folder. Several System Control panels, corresponding to 
various system configurations, are provided.

2. Open the panel for your system configuration by double-clicking its name in 
the list. For example, if your system includes an ICS-2000 and an AS50 
autosampler, double-click either ICS-2000_System_AS50.pan or ICS-
2000_Traditional_System_AS50.pan.

NOTE The two types of panels (system and traditional
system) are similar in function, but have different
“looks.” You can select either style, depending on
your personal preference.

When the Control panel opens, the controls on the panel are not enabled (see 
Figure 115). 

Figure 115. ICS-2000 Traditional System Control Panel (Unconnected) 
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3. To connect the Control panel to the ICS-2000, open the Control menu and 
click the name of the ICS-2000 timebase at the bottom of the menu.

The Control panel is now connected to the ICS-2000 and the controls are 
enabled (see Figure 116).

Figure 116. ICS-2000 Traditional System Control Panel (Connected to the ICS-2000)

This completes the ICS-2000 installation procedure. For routine operation, refer 
to ICS-2000 Ion Chromatography System Operator’s Manual (Document No. 
031857). The manual is on the Dionex Reference Library CD-ROM (P/N 
053891).
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24 Installation Troubleshooting

Problem: When the ICS-2000 power is turned on for the first time, a Windows 
message box appears asking for a USB configuration file (cmwdmusb.inf). 

Possible Cause: The USB cable was connected and the power turned on before 
Chromeleon was installed.

Solutions: 

Follow these steps to resolve the problem:

1. Click Cancel in the Windows message box. 

2. Turn off the power to the USB device and unplug the USB cable from the 
computer. 

3. Install Chromeleon (see Section 4).

4. Reconnect the USB cable to the computer and turn on the power to the 
device. Windows will now automatically recognize the USB device.
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